
Chapter 2
Multivariate Distributions

This chapter describes the multivariate location and dispersion (MLD) model,
random vectors, the population mean, the population covariance matrix, and
the classical MLD estimators: the sample mean and the sample covariance
matrix. Some important results on Mahalanobis distances and the volume of
a hyperellipsoid are given. Often methods of multivariate analysis work best
when the variables x1, ..., xp are linearly related. Section 2.4 discusses power
transformations to remove gross linearities from the variables.

2.1 Introduction

Definition 2.1. An important multivariate location and dispersion model is
a joint distribution with joint probability density function (pdf)

f(z|μ,Σ)

for a p×1 random vector x that is completely specified by a p×1 population
location vector μ and a p×p symmetric positive definite population dispersion
matrix Σ. Thus P (x ∈ A) =

∫
A

f(z)dz for suitable sets A.

Notation: Usually a vector x will be column vector, and a row vector xT

will be the transpose of the vector x. However,
∫

A

f(z)dz =
∫

A

f(z1, ..., zp)dz1 · · · dzp.

The notation f(z1, ..., zp) will be used to write out the components zi of a
joint pdf f(z) although in the formula for the pdf, e.g., f(z) = c exp(zT z),
z is a column vector.
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26 2 Multivariate Distributions

Definition 2.2. A p × 1 random vector x = (x1, ..., xp)T = (X1, ...,Xp)T

where X1, ...,Xp are p random variables. A case or observation consists of
the p random variables measured for one person or thing. For multivariate
location and dispersion, the ith case is xi = (xi,1, ..., xi,p)T . There are n
cases, and context will be used to determine whether x is the random vector
or the observed value of the random vector. Outliers are cases that lie far
away from the bulk of the data, and they can ruin a classical analysis.

Assume that x1, ...,xn are n iid p × 1 random vectors and that the joint
pdf of xi is f(z|μ,Σ). Also assume that the data xi has been observed and
stored in an n × p matrix

W =

⎡

⎢
⎣

xT
1
...

xT
n

⎤

⎥
⎦ =

⎡

⎢
⎢
⎢
⎣

x1,1 x1,2 . . . x1,p

x2,1 x2,2 . . . x2,p

...
...

. . .
...

xn,1 xn,2 . . . xn,p

⎤

⎥
⎥
⎥
⎦

=
[
v1 v2 . . . vp

]

where the ith row of W is the ith case xT
i and the jth column vj of W

corresponds to n measurements of the jth random variable Xj for j = 1, ..., p.
Hence the n rows of the data matrix W correspond to the n cases, while the
p columns correspond to measurements on the p random variables X1, ...,Xp.
For example, the data may consist of n visitors to a hospital where the p = 2
variables height and weight of each individual were measured.

Notation: In the theoretical sections of this text, xi will sometimes
be a random vector and sometimes the observed data. Some texts, for
example Johnson and Wichern (1988, pp. 7, 53), use X to denote the
n × p data matrix and an n × 1 random vector, relying on the context to
indicate whether X is a random vector or data matrix. Software tends to use
different notation. For example, R will use commands such as

var(x)

to compute the sample covariance matrix of the data. Hence x corresponds
to W , x[,1] is the first column of x, and x[4, ] is the 4th row of x.

2.2 The Sample Mean and Sample Covariance Matrix

The population location vector μ need not be the population mean, but often
the population mean is denoted by μ. For elliptically contoured distributions,
such as the multivariate normal distribution, μ is usually the point of sym-
metry for the population distribution. See Chapter 3.

Definition 2.3. If the second moments exist, the population mean of a
random p × 1 vector x = (X1, ...,Xp)T is

http://dx.doi.org/10.1007/978-3-319-68253-2_3


2.2 The Sample Mean and Sample Covariance Matrix 27

E(x) = μ = (E(X1), ..., E(Xp))T ,

and the p × p population covariance matrix

Cov(x) = E[(x − E(x))(x − E(x))T ] = E[(x − E(x))xT ] =

E(xxT ) − E(x)[E(x)]T = (σij) = (σi,j) = Σx.

That is, the ij entry of Cov(x) is Cov(Xi,Xj) = σij = E([Xi −E(Xi)][Xj −
E(Xj)]). The p×p population correlation matrix Cor(x) = ρx = (ρij). That
is, the ij entry of Cor(x) is Cor(Xi,Xj) =

σij

σiσj
=

σij√
σiiσjj

.

Let the p × p population standard deviation matrix

Δ = diag(
√

σ11, ...,
√

σpp).

Then
Σx = ΔρxΔ, (2.1)

and
ρx = Δ−1ΣxΔ−1. (2.2)

Let the population standardized random variables

Zi =
Xi − E(Xi)√

σii

for i = 1, ..., p. Then Cor(x) = ρx = Cov(z) is the covariance matrix of
z = (Z1, ..., Zp)T .

Definition 2.4. Let random vectors x be p × 1 and y be q × 1. The
population covariance matrix of x with y is the p × q matrix

Cov(x,y) = E[(x − E(x))(y − E(y))T ] =

E[(x − E(x))yT ] = E(xyT ) − E(x)[E(y)]T = Σx,y

assuming the expected values exist. Note that the q × p matrix Cov(y,x) =
Σy,x = ΣT

x,y , and Cov(x) = Cov(x,x).

A p×1 random vector x has an elliptically contoured distribution, if x has
pdf

f(z) = kp|Σ|−1/2g[(z − μ)T Σ−1(z − μ)], (2.3)
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and we say x has an elliptically contoured ECp(μ,Σ, g) distribution. See
Chapter 3. If second moments exist for this distribution, then

E(x) = μ and Cov(x) = cxΣ = Σx

for some constant cx > 0 where the ij entry is Cov(Xi,Xj) = σi,j .

Definition 2.5. Let x1j , ..., xnj be measurements on the jth random vari-
able Xj corresponding to the jth column of the data matrix W . The

jth sample mean is xj =
1
n

n∑

k=1

xkj . The sample covariance Sij estimates

Cov(Xi,Xj) = σij , and

Sij =
1

n − 1

n∑

k=1

(xki − xi)(xkj − xj).

Sii = S2
i is the sample variance that estimates the population variance

σii = σ2
i . The sample correlation rij estimates the population correlation

Cor(Xi,Xj) = ρij , and

rij =
Sij

SiSj
=

Sij√
SiiSjj

=
∑n

k=1(xki − xi)(xkj − xj)√∑n
k=1(xki − xi)2

√∑n
k=1(xkj − xj)2

.

Definition 2.6. The sample mean or sample mean vector

x =
1
n

n∑

i=1

xi = (x1, ..., xp)T =
1
n

W T1

where 1 is the n × 1 vector of ones. The sample covariance matrix

S =
1

n − 1

n∑

i=1

(xi − x)(xi − x)T = (Sij).

That is, the ij entry of S is the sample covariance Sij . The classical estimator
of multivariate location and dispersion is (x,S).

It can be shown that (n − 1)S =
∑n

i=1 xix
T
i − x xT =

W T W − 1
n

W T11T W .

Hence if the centering matrix H = I − 1
n
11T , then (n − 1)S = W T HW .

Definition 2.7. The sample correlation matrix
R = (rij).

That is, the ij entry of R is the sample correlation rij .

http://dx.doi.org/10.1007/978-3-319-68253-2_3
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Let the standardized random variables

Zj =
xj − xj√

Sjj

for j = 1, ..., p. Then the sample correlation matrix R is the sample covariance
matrix of the zi = (Zi1, ..., Zip)T where i = 1, ..., n.

Often it is useful to standardize variables with a robust location estimator
and a robust scale estimator. The R function scale is useful. The R code
below shows how to standardize using

Zj =
xj − MED(xj)

MAD(xj)

for j = 1, ..., p. Here MED(xj) = MED(x1j , ..., xnj) and MAD(xj) =
MAD(x1j , ..., xnj) are the sample median and sample median absolute devi-
ation of the data for the jth variable: x1j , ..., xnj . See Definitions 1.3 and 1.5.
Some of these results are illustrated with the following R code.

x <- buxx[,1:3]; cov(x)
len nasal bigonal

len 118299.9257 -191.084603 -104.718925
nasal -191.0846 18.793905 -1.967121
bigonal -104.7189 -1.967121 36.796311

cor(x)
len nasal bigonal

len 1.00000000 -0.12815187 -0.05019157
nasal -0.12815187 1.00000000 -0.07480324
bigonal -0.05019157 -0.07480324 1.00000000
z <- scale(x)
cov(z)

len nasal bigonal
len 1.00000000 -0.12815187 -0.05019157
nasal -0.12815187 1.00000000 -0.07480324
bigonal -0.05019157 -0.07480324 1.00000000

medd <- apply(x,2,median)
madd <- apply(x,2,mad)/1.4826
z <- scale(x,center=medd,scale=madd)
ddplot4(z)#scaled data still has 5 outliers
cov(z) #in the length variable

len nasal bigonal
len 4731.997028 -12.738974 -6.981262
nasal -12.738974 2.088212 -0.218569

http://dx.doi.org/10.1007/978-3-319-68253-2_1
http://dx.doi.org/10.1007/978-3-319-68253-2_1
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bigonal -6.981262 -0.218569 4.088479

cor(z)
len nasal bigonal

len 1.00000000 -0.12815187 -0.05019157
nasal -0.12815187 1.00000000 -0.07480324
bigonal -0.05019157 -0.07480324 1.00000000

apply(z,2,median)
len nasal bigonal
0 0 0
#scaled data has coord. median = (0,0,0)^T
apply(z,2,mad)/1.4826
len nasal bigonal
1 1 1 #scaled data has unit MAD

Notation. A rule of thumb is a rule that often but not always works well
in practice.

Rule of thumb 2.1. Multivariate procedures start to give good results for
n ≥ 10p, especially if the distribution is close to multivariate normal. In par-
ticular, we want n ≥ 10p for the sample covariance and correlation matrices.
For procedures with large sample theory on a large class of distributions, for
any value of n, there are always distributions where the results will be poor,
but will eventually be good for larger sample sizes. Norman and Streiner
(1986, pp. 122, 130, 157) gave this rule of thumb and note that some authors
recommend n ≥ 30p. This rule of thumb is much like the rule of thumb that
says the central limit theorem normal approximation for Y starts to be good
for many distributions for n ≥ 30. See the paragraph below Theorem 3.7.

The population and sample correlation are measures of the strength of a
linear relationship between two random variables, satisfying −1 ≤ ρij ≤ 1
and −1 ≤ rij ≤ 1. Let the p × p sample standard deviation matrix

D = diag(
√

S11, ...,
√

Spp).

Then
S = DRD, (2.4)

and
R = D−1SD−1. (2.5)

The inverse covariance matrix or inverse correlation matrix can be used
to find the partial correlation rij,x(ij) between xi and xj where x(ij) is
the vector of predictors with xi and xj deleted where i �= j. This partial
correlation is the correlation of xi and xj after eliminating the linear effects

http://dx.doi.org/10.1007/978-3-319-68253-2_3
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of x(ij) from both variables: regress xi and xj on x(ij) and get the two sets
of residuals, and then find the correlation of the two sets of residuals. If p ≥ 3
and S−1 = (Sij), then

rij,x(ij) =
−Sij

(SiiSjj)1/2
=

−rij

(riirjj)1/2
.

Srivastava and Khatri(1979, p. 53) proved this result. The second equality
holds since R−1 = DS−1D = (rij) = (Sij

√
Sii

√
Sjj).

Some R code illustrating this result is shown below. The function lsfit is
used to regress x1 on x3 and then regress x2 on x3. Note that x(i = 1, j =
2) = x3 once x1 and x2 have been deleted since p = 3.

x <- buxx[,1:3]; z<-solve(cor(x))
z #inverse correlation matrix

len nasal bigonal
len 1.02042523 0.13535798 0.06134196
nasal 0.13535798 1.02358206 0.08336109
bigonal 0.06134196 0.08336109 1.00931453

out1 <- lsfit(x[,3],x[,1])$resid
out2 <- lsfit(x[,3],x[,2])$resid
cor(out1,out2)
[1] -0.1324439

-z[1,2]/sqrt(z[1,1]*z[2,2])
[1] -0.1324439

zz <- solve(var(x)) #inverse covariance matrix
-zz[1,2]/sqrt(zz[1,1]*zz[2,2])
[1] -0.1324439

2.3 Mahalanobis Distances

Definition 2.8. Let A be a positive definite symmetric matrix. Then the
Mahalanobis distance of x from the vector μ is

Dx(μ,A) =
√

(x − μ)T A−1(x − μ).

Typically A is a dispersion matrix. The population squared Mahalanobis
distance

D2
x(μ,Σ) = (x − μ)T Σ−1(x − μ). (2.6)
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Estimators of multivariate location and dispersion (μ̂, Σ̂) are of interest.
The sample squared Mahalanobis distance

D2
x(μ̂, Σ̂) = (x − μ̂)T Σ̂

−1
(x − μ̂). (2.7)

Notation: Recall that a square symmetric p × p matrix A has an eigen-
value λ with corresponding eigenvector x �= 0 if

Ax = λx. (2.8)

The eigenvalues of A are real since A is symmetric. Note that if constant
c �= 0 and x is an eigenvector of A, then c x is an eigenvector of A. Let
e be an eigenvector of A with unit length ‖e‖ =

√
eT e = 1. Then e and

−e are eigenvectors with unit length, and A has p eigenvalue eigenvector
pairs (λ1,e1), (λ2,e2), ..., (λp,ep). Since A is symmetric, the eigenvectors are
chosen such that the ei are orthogonal: eT

i ej = 0 for i �= j. The symmetric
matrix A is positive definite iff all of its eigenvalues are positive, and pos-
itive semidefinite iff all of its eigenvalues are nonnegative. If A is positive
semidefinite, let λ1 ≥ λ2 ≥ · · · ≥ λp ≥ 0. If A is positive definite, then
λp > 0.

Theorem 2.1. Let A be a p×p symmetric matrix with eigenvector eigen-
value pairs (λ1,e1), (λ2,e2), ..., (λp,ep) where eT

i ei = 1 and eT
i ej = 0 if i �= j

for i = 1, ..., p. Then the spectral decomposition of A is

A =
p∑

i=1

λieie
T
i = λ1e1e

T
1 + · · · + λpepe

T
p .

Using the same notation as Johnson and Wichern (1988, pp. 50–51),
let P = [e1 e2 · · · ep] be the p × p orthogonal matrix with ith column
ei. Then PP T = P T P = I. Let Λ = diag(λ1, ..., λp) and let Λ1/2 =
diag(

√
λ1, ...,

√
λp). If A is a positive definite p × p symmetric matrix with

spectral decomposition A =
∑p

i=1 λieie
T
i , then A = PΛP T and

A−1 = PΛ−1P T =
p∑

i=1

1
λi

eie
T
i .

Theorem 2.2. Let A be a positive definite p × p symmetric matrix with
spectral decomposition A =

∑p
i=1 λieie

T
i . The square root matrix A1/2 =

PΛ1/2P T is a positive definite symmetric matrix such that A1/2A1/2 = A.

Points x with the same distance Dx(μ,A−1) lie on a hyperellipsoid. Let
matrix A have determinant det(A) = |A|. Recall that
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|A−1| =
1
|A| = |A|−1.

See Johnson and Wichern (1988, pp. 49–50, 102–103) for the following
theorem.

Theorem 2.3. Let h > 0 be a constant, and let A be a positive definite
p×p symmetric matrix with spectral decomposition A =

∑p
i=1 λieie

T
i where

λ1 ≥ λ2 ≥ · · · ≥ λp > 0. Then {x : (x − μ)T A(x − μ) ≤ h2} =

{x : D2
x(μ,A−1) ≤ h2} = {x : Dx(μ,A−1) ≤ h}

defines a hyperellipsoid centered at μ with volume

2πp/2

pΓ (p/2)
|A|−1/2hp.

Let μ = 0. Then the axes of the hyperellipsoid are given by the eigenvectors
ei of A with half length in the direction of ei equal to h/

√
λi for i = 1, ..., p.

In the following theorem, the shape of the hyperellipsoid is determined by
the eigenvectors and eigenvalues of Σ: (λ1,e1), ..., (λp,ep) where λ1 ≥ λ2 ≥
· · · ≥ λp > 0. Note Σ−1 has the same eigenvectors as Σ but eigenvalues
equal to 1/λi since Σe = λe iff Σ−1Σe = e = Σ−1λe. Then divide both
sides by λ > 0 since Σ > 0 and is symmetric. Let w = x − μ. Then points
at squared distance wT Σ−1w = h2 from the origin lie on the hyperellipsoid
centered at the origin whose axes are given by the eigenvectors of Σ where
the half length in the direction of ei is h

√
λi. Taking A = Σ−1 or A = S−1

in Theorem 2.3 gives the volume results for the following two theorems.

Theorem 2.4. Let Σ be a positive definite symmetric matrix, e.g., a
dispersion matrix. Let U = D2

x = D2
x(μ,Σ). The hyperellipsoid

{x|D2
x ≤ h2} = {x : (x − μ)T Σ−1(x − μ) ≤ h2},

where h2 = u1−α and P (U ≤ u1−α) = 1 − α, is the highest density region
covering 1 − α of the mass for an elliptically contoured ECp(μ,Σ, g) distri-
bution (see Definitions 3.2 and 3.3) if g is continuous and decreasing. Let
w = x − μ. Then points at a squared distance wT S−1w = h2 from the
origin lie on the hyperellipsoid centered at the origin whose axes are given by
the eigenvectors ei where the half length in the direction of ei is h

√
λi. The

volume of the hyperellipsoid is

2πp/2

pΓ (p/2)
|Σ|1/2hp.

http://dx.doi.org/10.1007/978-3-319-68253-2_3
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Theorem 2.5. Let the symmetric sample covariance matrix S be positive
definite with eigenvalue eigenvector pairs (λ̂i, êi) where λ̂1 ≥ λ̂2 ≥ · · · ≥ λ̂p >
0. The hyperellipsoid

{x|D2
x(x,S) ≤ h2} = {x : (x − x)T S−1(x − x) ≤ h2}

is centered at x. The volume of the hyperellipsoid is

2πp/2

pΓ (p/2)
|S|1/2hp.

Let w = x − x. Then points at a squared distance wT S−1w = h2 from the
origin lie on the hyperellipsoid centered at the origin whose axes are given
by the eigenvectors êi where the half length in the direction of êi is h

√
λ̂i.

From Theorem 2.5, the volume of the hyperellipsoid {x|D2
x ≤ h2} is pro-

portional to |S|1/2 so the squared volume is proportional to |S|. Large |S|
corresponds to large volume while small |S| corresponds to small volume.

Definition 2.9. The generalized sample variance = |S| = det(S).

Following Johnson and Wichern (1988, pp. 103–106), a generalized vari-
ance of zero is indicative of extreme degeneracy, and |S| = 0 implies that at
least one variable Xi is not needed given the other p − 1 variables are in the
multivariate model. Two necessary conditions for |S| �= 0 are n > p and that
S has full rank p. If 1 is an n × 1 vector of ones, then

(n − 1)S = (W − 1xT )T (W − 1xT ),

and S is of full rank p iff W − 1xT is of full rank p.
If X and Z have dispersion matrices Σ and cΣ where c > 0, then the

dispersion matrices have the same shape. The dispersion matrices determine
the shape of the hyperellipsoid {x : (x − μ)T Σ−1(x − μ) ≤ h2}. Figure 2.1
was made with the Arc software of Cook and Weisberg (1999a). The 10%,
30%, 50%, 70%, 90%, and 98% highest density regions are shown for two
multivariate normal (MVN) distributions. Both distributions have μ = 0. In
Figure 2.1a),

Σ =
(

1 0.9
0.9 4

)

.

Note that the ellipsoids are narrow with high positive correlation. In Figure
2.1b),

Σ =
(

1 −0.4
−0.4 1

)

.
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Note that the ellipsoids are wide with negative correlation. The highest den-
sity ellipsoids are superimposed on a scatterplot of a sample of size 100 from
each distribution.

Fig. 2.1 Highest Density Regions for 2 MVN Distributions
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2.4 Predictor Transformations

In regression, there is a response variable w1 = Y of interest, and predic-
tor variables w2, ..., wp are used to predict Y . In multivariate analysis, all p
random variables x1, ..., xp are of interest.

Predictor transformations are used to remove gross nonlinearities in the
predictors wi or the random variables xi, and this technique is often very
useful. Power transformations are particularly effective, and the techniques
of this section are often useful for general regression problems, not just for
multivariate analysis. A power transformation has the form x = tλ(w) =
wλ for λ �= 0 and x = t0(w) = log(w) for λ = 0. The modified power
transformation also has x = t0(w) = log(w), but for λ �= 0,

x = tλ(w) =
wλ − 1

λ
.

For both the power and modified power transformations, often λ ∈ ΛL

where
ΛL = {−1,−1/2,−1/3, 0, 1/3, 1/2, 1} (2.9)

is called the ladder of powers. Often when a power transformation is needed,
a transformation that goes “down the ladder,” e.g., from λ = 1 to λ = 0 will
be useful. If the transformation goes too far down the ladder, e.g., if λ = 0
is selected when λ = 1/2 is needed, then it will be necessary to go back “up
the ladder.” Additional powers such as ±2 and ±3 can always be added.

Definition 2.10. A scatterplot of x versus Y is used to visualize the
conditional distribution of Y |x. A scatterplot matrix is an array of scat-
terplots. It is used to examine the marginal bivariate relationships between
the random variables.

Often nine or ten variables can be placed in a scatterplot matrix. The
names of the variables appear on the diagonal of the scatterplot matrix. The
software Arc gives two numbers, the minimum and maximum of the variable,
along with the name of the variable. The software R labels the values of each
variable in two places; see Example 2.2 below. Let one of the variables be
W . All of the marginal plots above and below W have W on the horizontal
axis. All of the marginal plots to the left and the right of W have W on the
vertical axis.

If n is large and the p random variables come from an elliptically con-
toured distribution, then the subplots in the scatterplot matrix should be
linear. Nonlinearities suggest that the data does not come from an ellipti-
cally contoured distribution. There are several rules of thumb that are useful
for visually selecting a power transformation to remove nonlinearities from
the random variables.
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Rule of thumb 2.2. a) If strong nonlinearities are apparent in the scat-
terplot matrix of the random variables x1, ..., xp, it is often useful to remove
the nonlinearities by transforming the random variables using power trans-
formations.

b) Use theory if available.

c) Suppose that variable X2 is on the vertical axis and X1 is on the hori-
zontal axis and that the plot of X1 versus X2 is nonlinear. The unit rule says
that if X1 and X2 have the same units, then try the same transformation for
both X1 and X2.

Assume that all values of X1 and X2 are positive. Then the following six
rules are often used.

d) The log rule states that a positive predictor that has the ratio between
the largest and smallest values greater than ten should be transformed to logs.
So X > 0 and max(X)/min(X) > 10 suggests using log(X).

e) The range rule states that a positive predictor that has the ratio
between the largest and smallest values less than two should not be trans-
formed. So X > 0 and max(X)/min(X) < 2 suggests keeping X.

f) The bulging rule states that changes to the power of X2 and the power
of X1 can be determined by the direction that the bulging side of the curve
points. If the curve is hollow up (the bulge points down), decrease the power
of X2. If the curve is hollow down (the bulge points up), increase the power
of X2. If the curve bulges toward large values of X1, increase the power of
X1. If the curve bulges toward small values of X1, decrease the power of X1.
See Tukey (1977, pp. 173–176).

g) The ladder rule appears in Cook and Weisberg (1999a, p. 86).
To spread small values of a variable, make λ smaller.
To spread large values of a variable, make λ larger.

h) If it is known that X2 ≈ Xλ
1 and the ranges of X1 and X2 are such that

this relationship is one to one, then

Xλ
1 ≈ X2 and X

1/λ
2 ≈ X1.

Hence either the transformation Xλ
1 or X

1/λ
2 will linearize the plot. Note

that log(X2) ≈ λ log(X1), so taking logs of both variables will also linearize
the plot. This relationship frequently occurs if there is a volume present. For
example, let X2 be the volume of a sphere and let X1 be the circumference
of a sphere.

i) The cube root rule says that if X is a volume measurement, then the
cube root transformation X1/3 may be useful.

Theory, if available, should be used to select a transformation. Frequently,
more than one transformation will work. For example, if W = weight and X1
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= volume = (X2)(X3)(X4), then W versus X
1/3
1 and log(W ) versus log(X1) =

log(X2)+log(X3)+log(X4) may both work. Also if W is linearly related with
X2,X3,X4 and these three variables all have length units mm, say, then the
units of X1 are (mm)3. Hence the units of X

1/3
1 are mm.

Suppose that all values of the variable w to be transformed are positive.
The log rule says use log(w) if max(wi)/min(wi) > 10. This rule often works
wonders on the data, and the log transformation is the most used (modified)
power transformation. If the variable w can take on the value of 0, use
log(w + c) where c is a small constant like 1, 1/2, or 3/8.

To use the ladder rule, suppose you have a scatterplot of two variables
xλ1
1 versus xλ2

2 where both x1 > 0 and x2 > 0. Also assume that the plotted
points follow a nonlinear one to one function. Consider the ladder of powers

ΛL = {−1,−1/2,−1/3, 0, 1/3, 1/2, 1}.

To spread small values of the variable, make λi smaller. To spread large
values of the variable, make λi larger. For example, if both variables are right
skewed, then there will be many more cases in the lower left of the plot than
in the upper right. Hence small values of both variables need spreading.

Consider the ladder of powers. Often no transformation (λ = 1) is best,
then the log transformation, then the square root transformation, then the
reciprocal transformation.

Example 2.1. Examine Figure 2.2. Let X1 = w and X2 = x. Since w
is on the horizontal axis, mentally add a narrow vertical slice to the plot. If
a large amount of data falls in the slice at the left of the plot, then small
values need spreading. Similarly, if a large amount of data falls in the slice
at the right of the plot (compared to the middle and left of the plot), then
large values need spreading. For the variable on the vertical axis, make a
narrow horizontal slice. If the plot looks roughly like the northwest corner
of a square, then small values of the horizontal and large values of the ver-
tical variable need spreading. Hence in Figure 2.2a, small values of w need
spreading. Notice that the plotted points bulge up toward small values of the
horizontal variable. If the plot looks roughly like the northeast corner of a
square, then large values of both variables need spreading. Hence in Figure
2.2b, large values of x need spreading. Notice that the plotted points bulge
up toward large values of the horizontal variable. If the plot looks roughly
like the southwest corner of a square, as in Figure 2.2c, then small values
of both variables need spreading. Notice that the plotted points bulge down
toward small values of the horizontal variable. If the plot looks roughly like
the southeast corner of a square, then large values of the horizontal and small
values of the vertical variable need spreading. Hence in Figure 2.2d, small val-
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Fig. 2.2 Plots to Illustrate the Bulging and Ladder Rules

ues of x need spreading. Notice that the plotted points bulge down toward
large values of the horizontal variable.

Example 2.2. Mussel Data. Cook and Weisberg (1999a, pp. 351, 433,
447) gave a data set on 82 mussels sampled off the coast of New Zealand. The
response is muscle mass M in grams, and the predictors are a constant, the
length L, height H, and the width W of the shell in mm, and the shell mass
S. Figure 2.3 shows the scatterplot matrix of the predictors L, H, W , and S.
Examine the variable length. Length is on the vertical axis on the three top
plots, and the right of the scatterplot matrix labels this axis from 150 to 300.
Length is on the horizontal axis on the three leftmost marginal plots, and this
axis is labeled from 150 to 300 on the bottom of the scatterplot matrix. The
marginal plot in the bottom left corner has length on the horizontal and shell
on the vertical axis. The marginal plot that is second from the top and second
from the right has height on the horizontal and width on the vertical axis.
If the data is stored in x, the plot can be made with the following command
in R.

pairs(x,labels=c("length",‘"width","height","shell"))

Nonlinearity is present in several of the plots. For example, width and
length seem to be linearly related while length and shell have a nonlinear
relationship. The minimum value of shell is 10 while the max is 350. Since
350/10 = 35 > 10, the log rule suggests that log S may be useful. If log S
replaces S in the scatterplot matrix, then there may be some nonlinearity
present in the plot of log S versus W with small values of W needing spread-
ing. Hence the ladder rule suggests reducing λ from 1, and we tried log(W ).
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Fig. 2.3 Scatterplot Matrix for Original Mussel Data Predictors
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Fig. 2.4 Scatterplot Matrix for Transformed Mussel Data Predictors

Figure 2.4 shows that taking the log transformations of W and S results in
a scatterplot matrix that is much more linear than the scatterplot matrix of
Figure 2.3. Notice that the plot of W versus L and the plot of log(W ) versus
L both appear linear. This plot can be made with the following commands.
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z <- x; z[,2] <- log(z[,2]); z[,4] <- log(z[,4])
pairs(z,labels=c("length","Log W","height","Log S"))

The plot of shell versus height in Figure 2.3 is nonlinear, and small values
of shell need spreading since if the plotted points were projected on the
horizontal axis, there would be too many points at values of shell near 0.
Similarly, large values of height need spreading.

2.5 Summary

The following three quantities are important.
1) E(x) = μ = (E(x1), ..., E(xp))T .
2) The p × p population covariance matrix

Cov(x) = E(x − E(x))(x − E(x))T = (σij) = Σx.
3) The p × p population correlation matrix Cor(x) = ρx = (ρij).
4) The population covariance matrix of x with y is Cov(x,y) = Σx,y =

E[(x − E(x))(y − E(y))T ].
5) Let the p × p matrix Δ = diag(

√
σ11, ...,

√
σpp). Then Σx = ΔρxΔ,

and ρx = Δ−1ΣxΔ−1.
6) The n × p data matrix

W =

⎡

⎢
⎣

xT
1
...

xT
n

⎤

⎥
⎦ =

⎡

⎢
⎢
⎢
⎣

x1,1 x1,2 . . . x1,p

x2,1 x2,2 . . . x2,p

...
...

. . .
...

xn,1 xn,2 . . . xn,p

⎤

⎥
⎥
⎥
⎦

=
[
v1 v2 . . . vp

]
.

7) The sample mean or sample mean vector

x =
1
n

n∑

i=1

xi = (x1, ..., xp)T =
1
n

W T1

where 1 is the p × 1 vector of ones.
8) The sample covariance matrix

S =
1

n − 1

n∑

i=1

(xi − x)(xi − x)T = (Sij).
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9) (n − 1)S =
n∑

i=1

xix
T
i − x xT = (W − 1xT )T (W − 1xT ) = W T W −

1
n

W T11T W . Hence if the centering matrix H = I− 1
n
11T , then (n−1)S =

W T HW .
10) The sample correlation matrix R = (rij).
11) Let the p × p sample standard deviation matrix D = diag(

√
S11, ...,√

Spp). Then S = DRD, and R = D−1SD−1.
12) The spectral decomposition of the symmetric matrix A =∑p
i=1 λieie

T
i = λ1e1e

T
1 + · · · + λpepe

T
p .

13) Let A =
∑p

i=1 λieie
T
i be a positive definite p × p symmetric matrix.

Let P = [e1 e2 · · · ep] be the p × p orthogonal matrix with ith column ei.
Let Λ1/2 = diag(

√
λ1, ...,

√
λp). The square root matrix A1/2 = PΛ1/2P T is

a positive definite symmetric matrix such that A1/2A1/2 = A.
14) The population squared Mahalanobis distance

D2
x(μ,Σ) = (x − μ)T Σ−1(x − μ).
15) The sample squared Mahalanobis distance

D2
x(μ̂, Σ̂) = (x − μ̂)T Σ̂

−1
(x − μ̂).

16) The generalized sample variance = |S| = det(S).
17) The hyperellipsoid {x|D2

x ≤ h2} = {x : (x−x)T S−1(x−x) ≤ h2} is
centered at x and has volume equal to

2πp/2

pΓ (p/2)
|S|1/2hp.

Let S have eigenvalue eigenvector pairs (λ̂i, êi) where λ̂1 ≥ · · · ≥ λ̂p. If
x = 0, the axes are given by the eigenvectors êi where the half length in the
direction of êi is h

√
λ̂i. Here êT

i êj = 0 for i �= j while êT
i êi = 1.

18) A scatterplot of x versus y is used to visualize the conditional distri-
bution of y|x. A scatterplot matrix is an array of scatterplots. It is used
to examine the bivariate relationships of the p random variables.

19) There are several guidelines for choosing power transformations.
First, suppose you have a scatterplot of two variables xλ1

1 versus xλ2
2 where

both x1 > 0 and x2 > 0. Also assume that the plotted points follow a
nonlinear one to one function. The ladder rule: consider the ladder of
powers

−1,−0.5,−1/3, 0, 1/3, 0.5, and 1.

To spread small values of the variable, make λi smaller. To spread large values
of the variable, make λi larger.

20) Suppose that all values of the variable w to be transformed are positive.
The log rule says use log(w) if max(wi)/min(wi) > 10.
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21) If p random variables come from an elliptically contoured distribution,
then the subplots in the scatterplot matrix should be linear.

22) For multivariate procedures with p variables, we want n ≥ 10p. This
rule of thumb will be used for the sample covariance matrix S, the sam-
ple correlation matrix R, and procedures that use these matrices such as
principal component analysis, factor analysis, canonical correlation analysis,
Hotelling’s T 2, discriminant analysis for each group, and one way MANOVA
for each group.

2.6 Complements

Section 2.3 will be useful for principal component analysis and for prediction
regions. Fan (2017) gave a useful one-number summary of the correlation
matrix that acts like a squared correlation.

2.7 Problems

PROBLEMS WITH AN ASTERISK * ARE ESPECIALLY USE-
FUL.

2.1. Assuming all relevant expectations exist, show
Cov(Xi,Xj) = E(XiXj) − E(Xi)E(Xj).

2.2. Suppose Zi =
Xi − E(Xi)√

σii
. Show Cov(Zi, Zj) = Cor(Xi,Xj).

2.3. Let Σ be a p×p matrix with eigenvalue eigenvector pair (λ,x). Show
that cx is also an eigenvector of Σ where c �= 0 is a real number.

2.4. i) Let Σ be a p × p matrix with eigenvalue eigenvector pair (λ,x).
Show that cx is also an eigenvector of Σ where c �= 0 is a real number.

ii) Let Σ be a p×p matrix with the eigenvalue eigenvector pairs (λ1,e1), ...,
(λp,ep). Find the eigenvalue eigenvector pairs of A = cΣ where c �= 0 is a
real number.

2.5. Suppose A is a symmetric positive definite matrix with eigenvalue
eigenvector pair (λ,e). Then Ae = λe so A2e = AAe = Aλe. Find an
eigenvalue eigenvector pair for A2.

2.6. Suppose A is a symmetric positive definite matrix with eigenvalue
eigenvector pair (λ,e). Then Ae = λe so A−1Ae = A−1λe. Find an eigen-
value eigenvector pair for A−1.
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Problems using ARC

2.7∗. This problem makes plots similar to Figure 2.1. Data sets of n = 100
cases from two multivariate normal N2(0,Σi) distributions are generated and
plotted in a scatterplot along with the 10%, 30%, 50%, 70%, 90%, and 98%
highest density regions where

Σ1 =
(

1 0.9
0.9 4

)

and Σ2 =
(

1 −0.4
−0.4 1

)

.

Activate Arc (Cook and Weisberg 1999a). Generally this will be done by
finding the icon for Arc or the executable file for Arc. Using the mouse, move
the pointer (cursor) to the icon and press the leftmost mouse button twice,
rapidly. This procedure is known as double clicking on the icon. A window
should appear with a “greater than” > prompt. The menu File should be in
the upper left corner of the window. Move the pointer to File and hold the
leftmost mouse button down. Then the menu will appear. Drag the pointer
down to the menu command load. Then click on data and then click on demo-
bn.lsp. (You may need to use the slider bar in the middle of the screen to
see the file demo-bn.lsp: click on the arrow pointing to the right until the file
appears.) In the future, these menu commands will be denoted by “File >
Load > Data > demo-bn.lsp.” These are the commands needed to activate
the file demo-bn.lsp.

a) In the Arc dialog window, enter the numbers
0 0 1 4 0.9 and 100. Then click on OK.

The graph can be printed with the menu commands “File>Print,” but it
will generally save paper by placing the plots in the Word editor.

Activate Word (often by double clicking on the Word icon). Click on
the screen and type “Problem 2.7a.” In Arc, use the menu commands
“Edit>Copy.” In Word, click on the Paste icon near the upper left corner
of Word and hold down the leftmost mouse button. This will cause a menu
to appear. Drag the pointer down to Paste. The plot should appear on the
screen. (Older versions of Word, use the menu commands “Edit>Paste.”) In
the future, “paste the output into Word” will refer to these mouse com-
mands.

b) Either click on new graph on the current plot in Arc or reload demo-
bn.lsp. In the Arc dialog window, enter the numbers
0 0 1 1 −0.4 and 100. Then place the plot in Word.

After editing your Word document, get a printout by clicking on the upper
left icon, select “Print” then select “Print.” (Older versions of Word use the
menu commands “File>Print.”)

To save your output on your flash drive G, click on the icon in the upper
left corner of Word. Then drag the pointer to “Save as.” A window will
appear, click on the Word Document icon. A “Save as” screen appears. Click
on the right “check” on the top bar, and then click on “Removable Disk
(G:).” Change the file name to HW2d7.docx, and then click on “Save.”
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To exit from Word and Arc, click on the “X” in the upper right corner of
the screen. In Word, a screen will appear and ask whether you want to save
changes made in your document. Click on No. In Arc, click on OK.

2.8∗. In Arc enter the menu commands “File>Load>Data” and open the
file mussels.lsp. Use the commands “Graph&Fit>Scatterplot Matrix of.” In
the dialog window, select H, L, S, W, and M (so select M last). Click on
“OK” and include the scatterplot matrix in Word. The response M is the
edible part of the mussel while the 4 predictors are shell measurements. Are
any of the marginal predictor relationships nonlinear? Is E(M |H) linear or
nonlinear?

2.9∗. Activate the McDonald and Schwing (1973) pollution.lsp data set
with the menu commands “File > Load > Removable Disk (G:) > pollu-
tion.lsp.” Scroll up the screen to read the data description. Often simply
using the log rule on the predictors with max(x)/min(x) > 10 works won-
ders.

a) Make a scatterplot matrix of the first nine predictor variables and Mort.
The commands “Graph&Fit > Scatterplot-Matrix of” will bring down a Dia-
log menu. Select DENS, EDUC, HC, HOUS, HUMID, JANT, JULT, NONW,
NOX, and MORT. Then click on OK.

A scatterplot matrix with slider bars will appear. Move the slider bars for
NOX, NONW, and HC to 0, providing the log transformation. In Arc, the
diagonals have the min and max of each variable, and these were the three
predictor variables satisfying the log rule. Open Word.

In Arc, use the menu commands “Edit > Copy.” In Word, use the menu
commands “Edit > Paste.” This should copy the scatterplot matrix into the
Word document. Print the graph.

b) Make a scatterplot matrix of the last six predictor variables. The com-
mands “Graph&Fit > Scatterplot-Matrix of” will bring down a Dialog menu.
Select OVR65, POOR, POPN, PREC, SO, WWDRK, and MORT. Then click
on OK. Move the slider bar of SO to 0 and copy the plot into Word. Print
the plot as described in a).

R Problem

Note: For the following problem, the R commands can be copied and
pasted from (http://lagrange.math.siu.edu/Olive/mrsashw.txt) into R.

2.10. Use the following R commands to make 100 multivariate normal
(MVN) N3(0, I3) cases and 100 trivariate non-EC lognormal cases.

n3x <- matrix(rnorm(300),nrow=100,ncol=3)
ln3x <- exp(n3x)

In R, type the command library(MASS).

http://lagrange.math.siu.edu/Olive/mrsashw.txt
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Using the commands pairs(n3x) and pairs(ln3x) and include both scatter-
plot matrices in Word. (Click on the plot and hit Ctrl and c at the same time.
Then go to file in the Word menu and select paste.) Are strong nonlineari-
ties present among the MVN predictors? How about the non-EC predictors?
(Hint: a box- or ball-shaped plot is linear.)
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